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[bookmark: _Toc163496688]Purpose of the document
The aim of this guide is to help humanitarian organisations carry out their carbon footprint measurement using the HCC+ (Humanitarian Carbon Calculator Plus).
The Humanitarian Carbon Calculator Plus enables organisations to:
· Collect relevant data to calculate their carbon footprint for a given reporting year. It has been enhanced to collect data from organisations of up to 200 entities / delegations / country offices / regional offices.
· Assess their emissions using the GHG Protocol methodology.
· Display results as per the different scopes and sub-categories in the GHG protocol, at aggregated level, as well the breakdown for each entity. Detailed results emissions for each activity reported, can be easily exported and connected to an external data visualisation software (like for example Microsoft Power BI or Tableau).
This document summarises the structure and operation of the Excel tool. It is intended to help users and should be read before using the tool.
The tool was developed under Microsoft Excel 2016 and uses VBA macros. It is recommended to use this version or any later version of Microsoft Excel.

[bookmark: _Toc163496689]Context of the tool development 
The development of the Humanitarian Carbon Calculator reflects the collective and urgent need for action to mitigate climate change. It has been developed under the auspices of the Sustainable Supply Chain Alliance (an initiative led by the ICRC[footnoteRef:2] in collaboration with the IFRC[footnoteRef:3] and funding from Norwegian Ministry of Foreign Affairs) and in response to the adoption by over 300 organisations to date of the Climate and Environment Charter for Humanitarian Organisations. [2:  International Committee of the Red Cross]  [3:  International Federation of Red Cross and Red Crescent Societies] 

In 2021, consultations were organised by the Sustainable Supply Chain Alliance to define a carbon accounting methodology for humanitarian organisations, considering the experiences and practices already in place in some humanitarian organisations in terms of GHG emissions measurement. These consultations resulted in the validation of the GHG protocol as the reference carbon accounting standard to be applied, agreement on priority levels for each category of emissions and the definition of methodologies for calculating GHG emissions - all summarised in this document.
The Humanitarian Carbon Calculator V1 and an aggregation tool were developed and tested in 2022. The second version of the HCC, the HCC+, was developed and tested between 2023 and 2024.
The Humanitarian Carbon Calculator + enables humanitarian organisations to calculate their carbon footprint and identify the main sources of carbon emissions, in order to implement the most effective reduction solutions for their organisation. The enhanced version can accommodate up to 200 entities, making it possible to manage a large amount of data and input it into the tool more easily thanks to new features.
The tool is available on a free-to-download and free-to-use basis to all humanitarian organisations wishing to calculate their carbon footprint, complemented by a set of guidance documents and videos.


 [bookmark: OLE_LINK1]Please use this e-form to give us feedback on the tool and all the materials that have been shared in order to improve it in the future.




[bookmark: _Toc163496690]Overview 
[bookmark: _Toc163496691]Tool structure
The Carbon Calculator tool is divided into fifteen tabs, which are presented below: This tab contains instructions and general information to be filled in (e.g. number of entities, number of employees, total expenditure, reporting year etc...).
General information
The tab contains the emission factor database used to calculate GHG emissions.
Emissions factors 
This tab shows the results of the GHG footprint.
Results
PBI
This tab lists the results in a format that can be connected to a external data visualisation like Power BI so that they can be easily processed.
PBI 
Goods and services, cash assistance, in-kind donations, and financial support data tab.
Purchased Goods & Services
Energy data tab.
Fugitive emissions data tab.
Travel data tab. 
Capital goods data tab. 
Distributed products data tab.
Collection tabs 
Energy
Fugitive Emissions 
Travel
Capital Goods 
Distributed Products 
Waste data tab.
Waste 
Transportation and distribution data tab.
Transportation & Distribution 
Leased asset data tab.
Leased Assets
This tab allows to import activity data collected and spread it across the different collection tabs to calculate the footprint.
Data
This tab provides an overview of the different tabs in the Excel file, sub-categories with their priority level, and results (by scope 1, 2 and 3; data completeness and uncertainty).
Overview


[bookmark: _Toc163496692]Cell colours key
In all tabs, the following colour code has been used to clearly indicate the different cells expectations:
	Required data
	
	
	Cells coloured in yellow or red are those to be filled in (cells in red are particularly important for the correct functioning of the tool).

	Required data
	*
	Columns adorned with an asterisk must be filled by users.

	Modifiable data
	
	Cells coloured in brown are automatically updated but can be modified manually by users (only for advanced users).

	Unchanging data
	
	Cells coloured in grey are automatically updated without the need to enter further details.



[bookmark: _Use_of_the][bookmark: _Toc163496693]Tool use
Follow the steps below to calculate your carbon footprint.

[bookmark: _Toc163496694]Step 0: Launch the tool
The HCC+ tool contains VBA macros. You therefore need to activate the Excel macros to use the file and all its functions by making the document "trusted". A security warning appears when you open the document tool or when you try to run a macro (by pressing a button). You can then choose to make it a trusted document and activate the macros. 
Macros disabled warning bar:   [image: ]
1. Select "Enable content"
2. In the Security Warning dialog box, select "Yes" to make the document a trusted document.
[image: ]
If you've accidentally clicked "no", you can do the following: Click the File tab, and then click Options at the very bottom of the left bar. On the left-side pane, select Trust Center, and then click Trust Center Settings… . In the Trust Center dialog box, click Macro Settings on the left, select Enable all macros and click OK. Of course, you can always download a blank version of the tool if you think you've broken something.
When using the tool for the first time, it is advisable to save one empty version of the tool, organized according to the scope of your organisation and your accounting boundaries. In this way, you will have a template customised to your organisation and avoid having to repeat some time-consuming steps in subsequent years.
How to customize the HCC+?
· In each collection tab (energy, fugitive emissions, etc.), you can choose whether the proposed emission source is applicable to your organisation by setting the column M “Applicable?” to Yes or No. If the row is marked as not applicable, you should ensure that there are no values entered in the row's input data. The Tab Check button, which we will introduce below, allows you to check for errors and turns the cell red if there is a problem in the row.
· If you are certain that the proposed emission source will never be applicable to your organisation, you can delete the row completely. But keeping it with the value in column M as “No” will have the same effect in the calculations.
CAUTION: You must keep at least two lines per sub-category, even if they will never be applicable. The tool works with a certain number of sub-categories, so make sure you keep them.
The HCC+ allows organisations to disaggregate carbon accounting results according to parameters of their choice (thanks to the “Entity” breakdown). Entity detail allows each organisation to choose to disaggregate results at different levels, whether geographically (e.g. results can be disaggregated by region of operation, or by country office) or by project (e.g. results can be disaggregated by project codes). Care should be taken to ensure that the set of entities selected represents the entire organisation. It is also important to avoid double counting!


[bookmark: _Toc163496695]Step 1: Fill in the general information required to setup the tool 

0. Tab: General_Information
This tab provides instructions to read and general information to fill in about your organisation and the chosen disaggregation settings (entities that constitute the organisation). 
· DO NOT ADD OR DELETE ANY COLUMN OR ROW!

[image: ]
1. Fill in the organisation name 
2. Fill in the reporting year 
3. Fill in the number of entities (e.g. number of projects / missions / regional offices / country offices / delegations) 
!! Be careful, the choice of the number of entities and the scope is a strategic element for your emissions report. It will enable your emissions to be broken down to the desired level of granularity. However, care must be taken to avoid double counting and to ensure that the scope chosen covers the entire organisation.
At the same time the tool will adapt to your number of entities, so it is important to keep it right from the beginning.

4. Indicate the currency used for the Global Budget / Expenditure entered in the table immediately below. WARNING: for any activity data entered in the other tabs of the calculator, you MUST ensure that the unit of measure corresponds to the unit requested by the emission factor (EF).
[image: ]
5. Fill in the table including: 
* = information to be filled in, the tool will not work properly without this necessary information.
a. * Entity ID (e.g. name of each project / mission / regional office / country office / delegation)
b. Super Entity ID (e.g. name of the “super entity” which includes the entity, this box is used to group several entities together to make it easier to output grouped results (for example, to group several offices in the same country so that you can then compare several countries)) (if applicable, optional field)
c. * Internal number of personnel (Full time equivalents) for each entity 
d. External number of FTE for each entity (e.g. volunteers) (if applicable)
e. The surface of each entity in m² (if available, optional field)
f. * Global budget / expenditure of each entity
Completing this table allows you to detail the allocations (columns J to Q). Allocations are used to distribute emissions between the different entities when only global data is available (for example, if we have a single figure for the number of hotel nights, we can choose to distribute the emissions linked to these hotel nights according to the number of employees present in each entity). For more information on allocations, please consult the dedicated section Allocations.
The above information also enables the tool to make the calculation in tab ‘Results’ of the indicators in rows 5-8 of emissions per number of personnel, per m2 of office used and per unit of currency in the global expenditure. 

· If there are more than 10 entities, use the "+" button on the left of your screen to display the necessary lines and then ungroup them so that only the lines that concern you are displayed. To group or ungroup rows, use the dedicated command in the Excel menu.


There are two options to input the data into the calculator, both with equivalent results:
a) Existing method used in the initial version of HCC: type the data manually across the different data collection tabs (i.e. Energy, Fugitive_Emissions, Goods_&_Services, etc) as it was explained in the user manual of the HCC, however note that in the HCC+ there is no limitation of only 30 entities, but the tool can accommodate up to 200 entities. In this case go directly to Step 3: Check data in each collection tab.
b) A new method by which users can compile the different datasets from different data sources in the organisation, with the breakdown of activity data across the different entities. If properly formatted and emissions factors selected, the HCC+ can then propagate the activity data across the different data collection tabs. In this case continue to Step 2: Gather the data required to calculate your emissions in the Data tab. 

For organisations with a low number of entities and those starting to use and get familiar with the HCC, option a) might be more advisable. While organisations with already experience in using the HCC and carbon accounting, and with a big number of entities, option b) might be more interesting.



[bookmark: _Ref162190751]

[bookmark: _Toc163496696]Step 2: Gather the data required to calculate your emissions in the Data tab  

0. Tab: Data
This tab is used to compile and classify the data to be treated in the tool. The "Data Distribution" button at the top of the tab is then used to automatically spread the data across the different collection tabs in the tool. The “Clear Collection Tabs” button is used to clear all the data entered in the collection tabs (but not the data entered in the Data tab, which will not be lost, don't worry).

· DO NOT ADD OR DELETE ANY COLUMN OR ROW!
[image: ]

In this tab, you should therefore enter the figures relating to your carbon footprint in column H. These data are the values that will be distributed in each collection tab between the P and HH columns according to the entity concerned and the associated emissions item. For example, you can enter here the number of litres of LPG consumed by your stationary combustion sources in a given entity, and this value will be automatically sent by pressing the Data Distribution button in the corresponding tab and cell.

For each item of data in column H, you must enter at least 4 specific pieces of information:

1. The entity concerned by the data (the name of the entity should match exactly as it is written in the general information tab) or the word "Global" if the data concerns all entities (the allocation rule applied will then be the application entered in the line of the tab concerned by the data).

2. The category of the data and therefore the tab in which it will be copied, spelt exactly like the tab names (with the underscore "_" and ampersands "&") either Energy or Fugitive_Emissions or Goods_&_Services or Travels or Capital_Goods or Distributed_Products or Waste or Transportation_&_Distribution or Leased_Assets.
WARNING: if the name of the category is not spelt like the tabs, the data distribution macro will not be able to run successfully. Check whether there is any error/mismatch using column Q.
3. The EF sub-category concerned by the data (which must therefore already exist in the dedicated tab). Check whether there is any error/mismatch using column R.

4. The EF ID, i.e. the identifier of the emissions factor to which the data relates (more information in section Emission factors). 

If there is an error in the data entered, the Data Distribution button, mentioned below, will point out the error to be modified and cancel the data distribution.



[image: ]How to enter your data: 
a. Scenario A: You only have data at the global level: fill in the data and enter “Global” in the Entity column. The tool will then distribute the data between the different entities according to the allocation method chosen in the collection tab corresponding to the category you have indicated. Default allocations are selected (in column L of the collection tabs), so check that this corresponds to what you want.
b. Scenario B: You have data for each entity: fill in the Entity name in the appropriate column.
c. Scenario C: You have data for certain entities, but other entities are not concerned. Then you should put 0 to the entities that are not concerned (you can do it in the Data tab or directly in the collection tabs). It is important to fill in these zero values so that the completeness score is accurate.
d. Scenario D: You have data only for some entities: fill in the entities for which you have data and leave blank the entities for which you do not know the values. The tool will consider these omissions as missing information and will modify your completeness score accordingly. 

[image: ] 


There are other columns to help you:

a. Data name: allows you to enter the name of your data to specify what the figure relates to. 
How to make a consistency check? Column O ‘EF Name’ will automatically display the name of the emission factor entered in column F ‘EF ID’. If both names match column P ‘EF Name (consistency check)’ will show “TRUE”, otherwise it will show “FALSE”. In the second case, you should probably look why this inconsistency (maybe you should select a different EF ID in column F).

b. Unit: is used to enter the unit of measure for the data in column H.
How to make a consistency check? Column M ‘EF Unit’ will automatically display the unit of measure of the emission factor entered in column F ‘EF ID’. If both units match column N ‘Unit (consistency check)’ will show “TRUE”, otherwise it will show “FALSE”. In the second case, you will have to fix the issue by converting your data to the exact unit of measure of the emission factor (column N).
The unit of the data must ALWAYS match to that of the EF.

· Pay attention to the unit requested for each data (you must enter your value in the unit required by the emission factor you have selected, otherwise, the results will be distorted).

c. Data Source: allows you to enter the name of the file, or name of the person or department where the data comes from. This can be useful for filtering data according to one of the sources or keeping record for the next time the carbon accounting tool will be filled in. Note this is data is optional and only for your internal informative purposes.

d. Filter 1 (free text): an optional field that allows you to create a filter according to your needs to easily display certain data. For example, you could enter the name of the person or department responsible for the data, also, if your organisation follows geographical hierarchy, you could enter here the name of the region, or sub-region where an entity country belongs to, you also could enter sub-sub-categories to help you find your way around this tab if it becomes too large, or you could put de department in charge of the emissions... This information will be retrieved from the PBI output tab, so it will be possible to carry out analyses with the results, sort your data according to these filters etc... An important point to note: you should not rely solely on these filters to analyse your footprint, as they may not cover all your emissions if certain lines do not have a filter.

e. Filter 2 (free text): allows you to create another filter according to your needs to easily display certain data. For example, you could enter the name of the person or department responsible for the data, also, if your organisation follows geographical hierarchy, you could enter here the name of the region, or sub-region where an entity country belongs to, you also could enter sub-sub-categories to help you find your way around this tab if it becomes too large, or you could put de department in charge of the emissions...   This information will be retrieved from the PBI output tab, so it will be possible to carry out analyses with the results, sort your data according to these filters etc... An important point to note: you should not rely solely on these filters to analyse your footprint, as they may not cover all your emissions if certain lines do not have a filter.

f. EF Unit: unit of measure of the emission factor entered in column F. It is automatically displayed (calculated). In case the EF ID in column F does not correspond to any emission factor in tab ‘Emission_Factors’, ‘EF unit’ will be blank and ‘Unit (consistency check)’ will be “FALSE”. You will have to fix that problem: either selecting a correct EF ID or adding a new emission factor in tab ‘Emission Factors’, more information in section Emission factors.
WARNING: it may be necessary to extend the formula to the last row of your dataset, because it might be larger than the number of rows considered by default in the blank HCC+ Excel file. You can therefore extend the formulas from cell M5 or from the last M column cell with data to the last line with your values. If necessary, you can also copy the formula present in cell M1 and paste it to all the rows in column M.

g. Unit (consistency check): this column is calculated automatically using a formula, so you don't need to write anything on it. As mentioned already above, column M ‘EF Unit’ will automatically display the unit of measure of the emission factor entered in column F ‘EF ID’. If the value matches the one in column I ‘Unit’, then column N ‘Unit (consistency check)’ will show “TRUE”, otherwise it will show “FALSE”. In the second case, you will have to fix the issue by converting your data to the exact unit of measure of the emission factor (column N). Therefore, all values in this column should be “TRUE”. To identify and treat errors, you should apply a filter to this column selecting values “FALSE” and  for each row you will have to fix the issue by converting your data to the exact unit of measure of the emission factor (column N).
WARNING: it may be necessary to extend the formula to the last row of your dataset, because it might be larger than the number of rows considered by default in the blank HCC+ Excel file. You can therefore extend the formulas from cell N5 or from the last N column cell with data to the last line with your values. If necessary, you can also copy the formula present in cell N1 and paste it to all the rows in column N. 

h. EF Name: name of the emission factor entered in column F.
WARNING: it may be necessary to extend the formula to the last row of your dataset, because it might be larger than the number of rows considered by default in the blank HCC+ Excel file. You can therefore extend the formulas from cell O5 or from the last O column cell with data to the last line with your values. If necessary, you can also copy the formula present in cell O1 and paste it to all the rows in column O. 

i. EF Name (consistency check): this column is calculated automatically using a formula. As mentioned already above, column O ‘EF Name’ will automatically display the name of the emission factor entered in column F ‘EF ID’. If the value matches the one in column H ‘Data name’, then column P ‘Name (consistency check)’ will show “TRUE”, otherwise it will show “FALSE”. Therefore, all values in this column should be “TRUE”. To identify and treat errors, you should apply a filter to this column selecting values “FALSE” and for each row you should look why this inconsistency (maybe you should select a different EF ID in column F?). 
WARNING: it may be necessary to extend the formula to the last row of your dataset, because it might be larger than the number of rows considered by default in the blank HCC+ Excel file. You can therefore extend the formulas from cell P5 or from the last P column cell with data to the last line with your values. If necessary, you can also copy the formula present in cell P1 and paste it to all the rows in column P..

j. Category (consistency check): this column is automatically calculated and will show "ERROR" if there is a discrepancy between the category entered in column D and the name of the existing tabs in the tool. As a reminder, the values of the categories must be Energy or Fugitive_Emissions or Goods_&_Services or Travels or Capital_Goods or Distributed_Products or Waste or Transportation_&_Distribution or Leased_Assets.
To identify and fix errors, you should apply a filter to this column selecting values “ERROR”.
WARNING: it may be necessary to extend the formula to the last row of your dataset, because it might be larger than the number of rows considered by default in the blank HCC+ Excel file. You can therefore extend the formulas from cell Q5 or from the last Q column cell with data to the last line with your values. If necessary, you can also copy the formula present in cell Q1 and paste it to all the rows in column Q.

k. [bookmark: _Hlk162213274]Sub-Category (consistency check): this column is also automatically calculated and will show "ERROR" if there is a discrepancy between the sub-category entered in column E and the name of the existing sub-categories in the tool. As a reminder, the sub-category must exist in the corresponding category / tab. The list is available here.
To identify and fix errors, you should apply a filter to this column selecting values "ERROR".
WARNING: it may be necessary to extend the formula to the last row of your dataset, because it might be larger than the number of rows considered by default in the blank HCC+ Excel file. You can therefore extend the formulas from cell R5 or from the last R column cell with data to the last line with your values. If necessary, you can also copy the formula present in cell R1 and paste it to all the rows in column R.

· Please note that there should not be two rows with the same entity and the same EF ID because the system will not compute a sum/aggregation of both entries, but instead it will only consider the last entry. You can either combine both entries summing up the activity data (and adding the relevant information in column ‘Data Source’), or you can create another EF ID for the same EF see the section on Emission factors.




Data Distribution button
[image: ]

Once you have entered the data in the tab and you have checked there are no errors in the control columns N, P, Q, R, press the "Data Distribution" button. The tool will then spread each data item across all rows in the tab to the corresponding column and row. If there is an error, don't panic: an error code will appear on the screen, explaining in which column and which row there is a problem and reminding you of the rule to follow to launch and run the macro.


Clear Collection Tabs button
[image: ]

If you have mistakenly entered the wrong information into the tool, to start the distribution again with corrected information, or simply to clear the air before deallocating your information, you can delete the data contained in the collection tabs using the "Clear Collection Tab" button. Please note that it will only clear the data contained in the collection tabs and not the data contained in the Data tab. You can use again the button “Data distribution”, if applicable.


[bookmark: _Ref162190685][bookmark: _Toc163496697]Step 3: Check data in each collection tab 

0. Collection tabs
These tabs perform the calculations for each emissions category and sub-category. The "Tab Check" button at the top of the tab can be used to check that there are no errors in data entry.

· DO NOT ADD OR DELETE ANY COLUMN!

Once you've entered your data in the Data tab and pressed the button to distribute the values in the tool, the next step is to navigate through each collection tab to make a few checks and changes.

1. Select a first tab and take the following actions.
	Energy
	Fugitive Emissions
	Purchased goods and services
	Travels
	Capital goods
	Distributed products
	Waste
	Transportation and distribution
	Leased assets



a) Applicability
Indicate in all tabs, and each row of data, whether the different emission factor names are applicable to your organisation, by selecting either Yes or No in column M. 
[image: ][image: ] 
By selecting Yes, you mean that this data is relevant to at least one entity of your organisation; by selecting No, you mean that this data is not applicable at all for your organisation. 

b) Allocation 
For each "Global" data item, check the allocation rule selected in column L. 
[image: ][image: ]
The allocation type rule will be used to distribute the emissions linked to this item to the various entities if the data is at a global level. Given that the aim is to calculate the footprint of an entire organisation at entity level, the global data must not interfere with the breakdown of emissions. Allocation assumptions must therefore be defined so that emissions are distributed between each entity according to a certain logic. Allocations have been predefined for each sub-category, but can be modified (for advanced users, see Allocations). The allocation rules only apply to data where the entity mentioned is "Global".  For example, if you have a global figure for the number of litres of petrol consumed by your organisation, you can choose to divide this up between your various entities according to their respective budgets, by selecting the allocation “Budget” or you can choose to modify this, preferring for example to divide up emissions according to the number of employees in each entity, by selecting “FTE internal” etc... The data used comes from the General_Information tab, so be sure to fill it in completely.

c) Certainty
Indicate in all the tabs and for each row of data a data certainty level(from 25% to 100%.), i.e. the degree of confidence that can be placed in the value entered.
[image: ][image: ]
· Certainty 25%:	The data is estimated from public figures or national studies (e.g. the national average of office waste volume per person per year, multiplied it by the total number of employees to get the total waste volume).
· Certainty 50%: The data is estimated or extrapolated from available data (e.g. data from offices wastes by employee per month, extrapolated for a whole year for the total number of employee).
· Certainty 75%:	The data is derived from reliable assumptions or relevant extrapolations (e.g. data source in kWh from energy receipts for the last 10 months extrapolated for the last 2 months, to give the total energy consumption in kWh over 12 months).
· Certainty 100%	: The data is reliable, accurate without any extrapolation (e.g. data source coming from IT systems, invoices, receipts, accounting, etc.).
The value is indicative and applies to the entire line. Good practice is to level this score downwards: if the data for one entity is very uncertain, 25% should be given to the entire line, even if the data for the other entities is of very high quality.
These scores will impact the overall quality score for the footprint. They are used in particular to define what needs to be worked on to obtain better data in the future. In general, it is necessary to work on the quality of the most emissive items with the lowest quality of information. (Note that the main aim should be to reduce emissions; good data quality is not an end in itself!)

d) Completeness
The completeness score is calculated based on the number of entities without data. Therefore, it is important to distinguish entities where the information is missing (by leaving the cell empty), and entities where the data is zero (by putting 0 in the corresponding cell).
If an entity is not concerned by a data item but the line is still applicable at the organisation level (applicable in other entities), make sure that the input data item is "0", otherwise, it will decrease the completeness score. Empty data is considered as missing in the completeness calculation.

e) Comments
You can use column C "Comments" to comment on the file, particularly if several people are working on it. The data entered here will be saved and restored in the "PBI" data export tab.

f) Checks
Pay close attention to units and conversion errors. Errors of factors 10, 100, or 1000 are very common and can significantly vary your footprint. 
· Exclude VAT for all monetary data (kEUR or kUSD) such as purchased services, capital goods (in kEUR), travel (in kEUR), etc… kEUR means thousands of euros.

Click on the "Tab Check" button to verify the information that has been entered. In particular, the macro checks that there are no errors relating to applicability or duplicate EFIDs. If necessary, please refer to the row where the macro reported an error (cell in red in column D or L) so that you can correct it. 
Tab Check button
[image: ]

The button is used to check that there are no duplicate EFIDs and that the lines marked as inapplicable contain no data. If there is a problem, the macro displays an error message to explain which errors need to be corrected and colours in red the cells in column D or L where there are errors. If there are no problems, the macro displays a message saying that everything is fine, and that the user can continue.

2. Repeat these actions (from a to f) for each collection tab then view your results!



How to add a line to a sub-category
· If you need to add a row to a sub-category: 
· copy an existing row from that sub-category (1 screenshot below ) 
· and then insert the copied cells between two rows in that same sub-category (2 screenshot below) (you should not paste a row above the first row or below the last row in the sub-category, as this will distort the results). This may take some time depending on the power of your computer as it requires it to do a lot of calculations. Don't panic and be patient, it can take from a few seconds to a few minutes.
· Finally select the relevant emission factor ID (3 screenshot below) (data will be updated automatically) and fill in the cells.
(1) [image: ]
(2) [image: ]
(3) [image: ]


· You can delete one or more rows in a sub-category, but there should always be at least two rows left in each sub-category (even if you display them as not applicable) so that you can add rows in the way explained above. 

[image: ][image: ]If you see #### instead of a number in a cell, it means that the column is not large enough to display the integer. You should then expand the column. 



[bookmark: _Toc163496698]Step 4: Consult your results (general and detailed)    

0. Tab: Results
Once all the data has been collected in the Data tab, distribute the data to the collection tabs using the "Data Distribution" button and check each tab using the "Tab Check" buttons, you will find results updated in the “Results” tab.

Two visions are available: 
- A general view of emissions, in GHG Protocol format
[image: ]
- A detailed view of emissions, for each entity and for each emission sub-category
[image: ]


[bookmark: _Toc163496699]Step 5: Extracting your data (inputs and outputs) to visualise or analyse in an external system

0. Tab: PBI
The PBI tab compiles all data relating to your carbon footprint so that you can easily use it with Power BI or any other data analysis/visualisation software.
To compile the data, press the “Data Centralisation” button. This button then launches a macro which will search for all the relevant information in the tool and store it in this tab. Depending on the quantity of information to be analysed, the macro may take more or less time.
[image: ]
The different columns allow you to analyse your results by scope, entity, super-entity, category, subcategory, GHG sub-categories… They also allow you to extract comments, filters and data relating to emission factors.
From year to year, you can extract data in this tab to compare your results, using the differentiation by year of inventory.

The data analysis then makes it possible to identify the most significant emission sources. Now it's a matter of doing something about them, analysing the most emissive items, finding ways of reducing them, setting ambitious but achievable targets and then drawing up a relevant action plan to get there. Reducing the footprint of major items must be part of the organisation's strategy. 

[bookmark: _Toc163496700]Collection tabs

Energy tab  (Priority level 1)Energy

This tab covers all data relating to your organisation stationary and mobile combustion, as well as electricity consumption. 
The tab relates to the following: 
· Sub-Categories:
· Stationary combustion: all activity data relating to the combustion of fossil fuels in a facility, warehouse or office operated or owned by the company (e.g. natural gas, piped gas, fuel oil, petrol)
· Mobile combustion: all activity data related to fuel combustion in owned or operated mobile sources (vehicles/generators) (e.g. petrol, diesel, LPG, LNG)
· Purchased electricity: all activity data related to electricity purchases per country and subdivided by continent (e.g. Africa, Asia and Middle East, Europe, North America, Oceania, South America)
· Heat and cooling: all activity data related to heat and cooling in a facility, warehouse or office operated or owned by the company
· Detailed results by gas: available in the ER to EX columns (CO2, CH4, N2O, HFCs, PFCs, SF6, other gases).

Fugitive emissions tab  (Priority level 1)Fugitive_Emissions 

This tab covers all data relating to your organisation’s refrigeration and air conditioning systems, fire extinguishing systems and the purchase and release of industrial gases.
The tab relates to the following:  
· Sub-Categories:
· Fugitive emissions: all activity data linked to a type of refrigerant used for air conditioning or fire extinguishing systems (e.g. NF3 or R401a)
· Detailed results by gas: available in the ER to EX columns (CO2, CH4, N2O, HFCs, PFCs, SF6, other gases).
[image: ]How to find the type of refrigerant and the value to be entered?
· To determine the type of refrigerant: consult the technical documents for your appliances or the labels or nameplates, which should indicate the type of refrigerant used and even the quantity of refrigerant contained in the equipment. 
· To obtain information on refills: consult the service and maintenance records to find out which refills have been carried out. In general, the quantity added corresponds to the refrigerant leakage value to be reported. 
· Don't hesitate to train the staff responsible for servicing and maintaining refrigeration equipment so that they are able to identify the types of refrigerant and determine the quantities that have leaked. 
· If in doubt, work with experts or specialised technicians so that they can provide you with advice and assistance.
· If possible, choose refrigerants with the lowest emissions factor.
Purchased goods and services tab (Priority levels 1 to 3)Goods_&_Services

This tab covers all data relating to goods purchased by your organisation (for humanitarian purposes or for its own account), purchased services, cash assistance, financial support, and in-kind donations.
The tab relates to the following:
· Sub-Categories:
· Financial support: all activity data relating to financial transfers made to another non-profit organisation, including humanitarian organisations, but also national organisations, authorities (e.g. hospitals, others non-profit organisations) (Priority level 1/2)
· In kind donations: all activity data relating to in-kind donations received by your organisation, including goods (first and second hand) such as clothing, services, time and expertise (e.g. services, textiles, other). In short, these are all goods and/ or services that have not been purchased by the organisation but have been received for distribution (Priority level 2/3)
· Cash assistance: all activity data relating to cash transfers (conditional or unconditional) to beneficiaries (by country) (e.g. cash assistance provided to beneficiaries in Abidjan, Algeria, or Caracas) (Priority level 1/2)
[image: ]How should financial assistance to another organisation be split between “financial support” and “cash assistance”?
· Example 1: You have supported a French organisation for 10 k€, of which you know that 20% will be spent on overheads and 80% on cash assistance. You can then divide the support between 2 k€ which will be allocated to financial support under the heading “Activity for voluntary organisations” and 8k€ which will be allocated to cash assistance under the heading “Cash assistance – France”.
· Example 2: You have supported an organisation for 10k€, of which you know that 20% will be spent on overheads and 80% on construction. You can then divide the support with 2 k€ allocated to financial support under the heading “Activity for voluntary organisations” and 8k€ allocated to financial support under the heading “Construction”. 

· Humanitarian products: all activity data relating to the purchase of goods for distribution to beneficiaries, broken down into health & care (medical, household and textile supplies), raw materials & machinery (construction or other raw material supplies such as plastic), and food, crops & breeding (food and agricultural supplies such as fertilizers) (Priority level 1)
· Purchased services: all activity data related to the purchase of services (in thousands of euros (k€) excluding VAT) (Priority level 1)

· Do not forget to apply:
· Conversion rate: to convert your monetary expenditure into euros (€), you should first use the correct conversion rate for your currency into euros. Make sure you use the correct year of conversion rates and update them according to the reporting year. 
· PPP: PPPs (Purchasing Power Parities) are currency conversion rates that equalise the purchasing power of different currencies by eliminating differences in price levels between countries. 


[image: ]Purchasing power parity (PPP) is a currency conversion rate used to express the purchasing powers of different currencies in common units. This rate expresses the ratio between the quantity of monetary units required in different countries to purchase the same “basket” of goods and services. The basket of goods and services whose prices are determined is a sample of all those that make up final expenditure, i.e. final consumption by households and government, capital formation and net exports. This indicator is measured in national currency units per US dollar. This conversion rate may be different from the “exchange rate”, as the exchange rate of one currency against another reflects their reciprocal values on the international financial markets and not their intrinsic values for a consumer.Conversion rate – PPP rates (PPA in French) – OCDE Data (oecd.org)


· Purchased goods: all activity data relating to the purchase of goods for your organisation (e.g. office supplies, mail, printing, plastics and paper) (Priority level 1)

Travels tab  (Priority level 1 to 2)Travels

This tab covers all data relating to your organisation’s travel (commuting, business travel, volunteer travel and hotel nights linked to these trips).
The tab relates to the following:  
· Sub-Categories:
· Business travels: all activity data related to employees’ transport for business-related activities during the reporting year (in vehicles not owned or operated by the reporting organisation) (Priority level 1)
· Employee commuting: all activity data relating to the transport of employees between home and work during the reporting year (in vehicles not owned or operated by the reporting organisation) (Priority level 1)
· Volunteers: all activity data relating to the transport of volunteers between home and work during the reporting year (in vehicles not owned or operated by the reporting organisation) (Priority level 2)
· Hotel: all activity data relating to hotel nights paid by the reporting organisation, during the reporting year, for its employees or volunteers during travel related to its activities. 
[image: ]How to consider homeworking in employee commuting? 
· Ideally, gather information regarding homeworking in your organisation (by conducting a survey for example), or set assumptions to apply a ratio to the annual commuting distances travelled by all employees for each mode of transport.




Capital goods tab  (Priority level 1)Capital_Goods 

This tab covers all data relating to your organisation’s capital goods acquired, rented or leased ONLY if it was acquired, rented or leased during the reporting year (e.g. new buildings, new IT equipment, new machines leased or acquired within the reporting year).
The tab relates to the following: 
· Sub-Categories:
· Buildings: all activity data relating to the rental or acquisition of new buildings during the reporting year
· IT equipment: all activity data relating to the rental or acquisition of new IT equipment (e.g. laptop, monitor, printer, etc.) during the reporting year 
· Vehicles: all activity data relating to the rental or acquisition of new vehicles during the reporting year 
· Furniture: all activity data relating to the rental or acquisition of new furniture within the reporting year

Distributed products tab  (Priority level 3)Distributed_Products 

This tab covers all data relating to the end-of-life, processing, and use of products distributed by your organisation.
The tab relates to the following: 
· Sub-Categories:
· End-of-life: all activity data related to the end-of-life of products distributed and associated with a waste treatment (e.g. plastic – recycled means that the product which is mainly composed of plastic will be recycled)
· Processing of sold products: all activity data linked to the processing of intermediate products (e.g. your organisation buys rice from a supplier, and the rice needs to be processed into tins before being distributed by a manufacturer. Then, the energy used by the manufacturer to process the rice should be included in this sub-category)
· FOR ADVANCED USERS ONLY: if necessary, please add the appropriate electricity emission factor, and ensure that the total emission is considered in scope 3 (instead of scopes 2 and 3), scope 2 and scope 3 emissions should be summed and placed in scope 3.
· Use of distributed products: all activity data related to the direct and indirect use phase of distributed products emissions (e.g. fuel, charcoal or energy required during the use phase of a product) (e.g. to heat rice before eating it).



Waste tab  (Priority level 3)Waste

This tab covers all data relating to operational waste.
The tab relates to the following: 
· Sub-Categories:
· Waste: all activity data relating to the disposal and treatment of waste (hazardous and non-hazardous) generated by your organisation (e.g. plastic or paper waste from offices).

Transportation and distribution tab  (Priority level 1)Transportation_&_Distribution 

This tab covers all data relating to the inbound transportation (from suppliers to your organisation), internal transportation (freight in between your organisation) and outbound transportation (from your organisation to your beneficiaries).
The tab relates to the following: 
· Sub-Categories:
· Upstream transportation: all activity data related to the freight of products between a company’s tier 1 suppliers and your own operations (e.g. from your supplier’s tiers 1 to your international or national warehouses / offices / others)
· Downstream transportation: all activity data related to the freight of products between the reporting company’s operations and the beneficiaries (e.g. from your international or national warehouses / offices / others to your beneficiaries)
[image: ]How to proceed without precise details concerning the freight itinerary? 
· Using the EFs that define the route taken is not required for the collection and processing of transportation data. For sea freight, start with EF "80312 - Container ship - Industry average (use if unknown origin destination pair)" and for road freight, use EF "80003 - Rigid truck <7,5t - Asia-Africa".
· Only experienced users who have already worked to reduce the tons.km transported and would like to start focusing efforts on different routes to hunt for alternatives to keep cutting emissions are advised to view the specific routes taken in detail.
· In general, when multiple similar emissive EFs are provided in the HCC and you are unsure which to choose, use the most emissive EF (conservative assumption).



Leased assets tab  (Priority level 3) !! FOR ADVANCED USERS ONLY !!Leased_Assets 

This tab covers all data relating to the end of life, processing and use of assets leased by your organisation.
The tab relates to the following: 
· Sub-Categories:
· Upstream leased assets: all activity data related to the acquisition, maintenance, and disposition of your organisation's upstream leased assets. This includes activities such as extraction of raw materials, manufacturing, transportation, and assembly of assets before leasing. For example, if your organisation rents vehicles, this subcategory would cover the emissions associated with manufacturing and shipping those vehicles until they are made available for rental.
Please refer to: https://ghgprotocol.org/sites/default/files/2022-12/Chapter8.pdf
· Downstream leased assets: all activity data related to the use and end of life of your organisation's downstream leased assets. This includes emissions generated during the period of use of leased assets, as well as emissions associated with their disposal or removal from service at the end of their life cycle. For example, for rented buildings, this would cover greenhouse gas emissions from the use of energy for heating, cooling, and lighting, as well as emissions associated with the demolition or renovation of the building. building at the end of the rental period.
Please refer to: https://ghgprotocol.org/sites/default/files/2022-12/Chapter13.pdf

[bookmark: _Toc163496701]Quality and completeness scores
The quality and completeness scores are calculated according to specific rules. The aim of these scores is to help you understand your results and take the right actions to improve your reporting.
 
Quality score
The overall quality score is based on the quality score for each category of your carbon footprint, which is calculated as follows:  
· The quality score of each sub-category formula is:Quality score = uncertainty level (tCO2e) / the total emission (tCO2e) of each category
Uncertainty level (tCO2e) is the GHG methodology calculation computing the data certainty and the uncertainty of the emission factor (see definition below)
Total emissions (tCO2e) are the emission associated with each data point

· The data certainty (from 25% to 100%), based on the data quality level you have assigned for each data, and by applying a weighted average to get a global quality percentage: 
· Quality 25%: The data is estimated from public numbers or national studies (e.g. you used the national average of office waste volume per person per year and multiplied it by the total number of employees to get the total volume of wastes)
· Quality 50%: The data is estimated or extrapolated from other available data (e.g. you measured an estimated data from offices wastes by employee and extrapolated for a whole year for the total number of employee)
· Quality 75%: The data is from reliable hypothesis or relevant extrapolations (e.g. data source in kWh from your energy receipts for the last 10 months so you need to extrapolate the last 2 months, so you can have the total 12 months energy consumption in kWh)
· Quality 100%: The data is reliable and precise (e.g. data source coming from IT systems, invoices, receipts, accounting, etc. and not extrapolated)

· The uncertainty of the emission factor is linked to the way in which each factor was created. Some emission factors are intrinsically highly uncertain (such as emission factors linked to monetary expenditure, for example). 

· To calculate the level of uncertainty, the idea is to combine the uncertainty of the emission factor and the uncertainty of the input data. To do this (the uncertainties being independent of each other), we use the uncertainty propagation method to reflect the relative contribution to the total uncertainty of the final result. (The two uncertainties are percentages.)
· Combined Uncertainty = √ (〖(EF Uncertainty)〗^2 +〖(Data Uncertainty)〗^2 )
 



Completeness score
The global completeness score represents the completeness of the data provided to calculate your carbon footprint. It averages the completeness scores of each sub-category, all weighted in the same way (i.e. no sub-category is considered as more important than another). Several scenarios are possible:
· Scenario 1: a line corresponding to an emission factor in a given category and subcategory is not applicable to your organisation, column M mentions not applicable, your score is not impacted because no data is expected here.
· Scenario 2: a line corresponding to an emission factor in a given category and subcategory is applicable to your organisation and you have a “Global” data, the completeness score of the line is 100%.  
· Scenario 3: a line corresponding to an emission factor in a given category and subcategory is applicable to your organisation and you have data for each entity, the completeness score of the line is 100%.
· Scenario 4:  a line corresponding to an emission factor in a given category and subcategory is applicable to your organisation and you have partial data (only for certain entities but not for all), the completeness score of the line is equal to the percentage of entities having data entered. (e.g. you have 5 sites, and you have the data for only 1 of them, your score will be 20%)
· Scenario 5: a line corresponding to an emission factor in a given category and subcategory is applicable to your organisation and you have no data for any entity, the completeness score of the line is 0%.
The completeness score for each sub-category is the average of the scores obtained for each FE line in the sub-category. The overall completeness score is then the average of the completeness scores for each sub-category.
Advanced featuresEmission_Factors 

[bookmark: _Ref160553449][bookmark: _Ref160553888][bookmark: _Toc163496703]Emission factors  

General information
This tab shows all emissions factors that are used within the tool to calculate the carbon footprintPlease use this e-form to compile new emission factors that the different organisations collect from well-recognized databases, suppliers or Life-Cycle Analysis for certain products/services commonly used in the humanitarian sector.



The tab is constructed as followed: 
Columns A to Y
· ID (column A): the ID number of the emission factor. The first digit reflects the order of the category (e.g. 1 for energy, 2 for fugitive emission, 3 goods and services, etc.) / the second digit reflects the sub category (e.g. 0 for stationary combustible, 1 for mobile combustible, 2 for electricity) / from the third digit to the last one, its reflects the order within the list (e.g. Hospital equipment (diagnostic imaging, compounding equipment), for in kind donations is 31012 – 3 for goods and services category, 1 for in-kind donation sub category and then 012 because it is the twelve emission factor from the in-kind donation of the category)
· If you need to add a new emission factor, refer to the “Add an EF” section and follow the ID methodology. If the ID number already exists the cell will turn red so change it, otherwise it means the ID is correct.
[bookmark: _Ref163468274]Description of the IDs
The list is constructed as followed for the categories and sub-categories, and the emission factor are classified by name from A to Z (ID first two digits)
	Category
	Sub-catgory
	ID

	Energy
	
	1XXXX

	
	Stationary combustion
	10XXX

	
	Mobile combustion
	11XXX

	
	Purchased electricity per continent (6 continents)
	120XX to 125XX

	
	Steam, heat, cooling
	13XXX

	Fugitive_Emissions
	
	2XXXX

	
	Refrigerants
	20XXX

	Goods_&_Services
	
	3XXXX

	
	Financial support
	30XXX

	
	In-kind donations
	31XXX

	
	Cash assistance per continent (6 continents)
	320XX to 325XX

	
	Humanitarian products
	33XXX

	
	Purchased services
	34XXX

	
	Catering
	35XXX

	
	Purchased goods
	36XXX

	Travels
	
	4XXXX

	
	Business travels
	40XXX

	
	Employee commuting
	41XXX

	
	Volunteers
	42XXX

	
	Hotel
	43XXX

	Capital_Goods
	
	5XXXX

	
	Buildings
	50XXX

	
	Vehicles
	51XXX

	
	Furniture and machinery
	52XXX

	
	IT equipment
	53XXX

	Distributed_Products
	
	6XXXX

	
	Use of distributed products
	60XXX

	
	Processing of distributed products
	61XXX

	
	End of life of distributed products
	62XXX

	Waste
	
	7XXXX

	
	Hazardous waste
	71XXX

	
	Non hazardous waste
	72XXX

	Transportation_&_Distribution
	
	8XXXX

	
	Upstream transportation and distribution
	80XXX

	
	Downstream transportation and distribution
	81XXX

	Leased_Assets
	
	9XXXX

	
	Upstream leased assets
	90XXX

	
	Downstream leased assets
	91XXX



· Category (column B): the emission factor category according to the GHG Protocol (e.g. energy, goods, and services, etc.). The "Category" column of your data tab should only be filled with names from this list. 
· Sub-category (column C): the emission factor sub-category according to your specific operation and the GHG Protocol categories. The "EF Sub-Category" column of your data tab should only be filled with names from this list.
· Name (column D): the name relating to the emission factor, to what it calculates. Generally, the name is specified directly by the database that provides the EF.
· Unit (column E): the unit for the emission factor, which determine the unit required for the data (e.g. Petrol is kgCO2e / liter meaning the data needs to be fill in liter of petrol consumed for the reporting year)
· Exclude VAT for all monetary data (kEUR or kUSD) such as purchased services, capital goods (in kEUR), travel (in kEUR), etc… kEUR means thousands of euros.
· Source (column F): the databased where the emission factor is coming from. All emissions factors come from international and recognized database (e.g. Base Carbone – ADEME, Ecoinvent, DEFRA (Conversion factor 2022 BEIS))
· Year (column G): the last knowing year when the emission factor was updated (e.g. Butane – Base Carbone – ADEME – 2017 – Europe means that the ADEME database last update on butane emission factor was 2017 and remains the same number as of today)
· Location (column H): the location from which the emission factor was calculated (e.g. Butane – Base Carbone – ADEME – 2017 – Europe means that the ADEME calculate the emission factor based on European countries)
· Uncertainty (column I): the uncertainty associated with each emission factor (e.g. Butane – Base Carbone – ADEME – 2017 – Europe – 5% means that the emission factor has a 5% uncertainty). To get an uncertainty percentage of the emission factor, either it is given by the database when it is a generic EF, or ask the EF provider for the uncertainty level 
· EF (column J): the total amount of the emission factor (e.g. Butane – Base Carbone – ADEME – 2017 – Europe – 5% - 3.52062 kgCO2e/liter means that for one liter of Butane, the associated emission is 3,52062 kgCO2e
· This EF column is the total of scope 1, 2 and 3 columns (columns L, T and U)
· Scope 1 (column K): the scope 1 amount of the emission factor, and breakdown by different gas equivalents such as CO2, CH4, HFCs, PFCs, SF6, other gases (e.g. Butane – 3.52062 kgCO2e/liter total emissions with 3,01562 kgCO2e/liter for scope 1 and divided between 2.98 for CO2, 0.00 for CH4, 0.03 for N2O and 0 for HFCs, PFCs and other gases)
· The scope 1 total should be equivalent to the sum of the gases (columns M to S), if not the cell will appear in red
· Scope 2 (column S): the scope 2 amount of the emission factor (e.g. Butane – 3.52062 kgCO2e/liter total emissions with 0 kgCO2e/liter for scope 2)
· Scope 3 (column T): the scope 3 amount of the emission factor, and breakdown between the upstream, production, transport, and end-of-life parts (e.g. Butane – 3.52062 kgCO2e/liter total emissions with 0.505 kgCO2e/liter for scope 3 related to the upstream and losses part of the combustion)
· The scope 3 total should be equivalent to the sum of the upstream, production, transport, and end-of-life part of your emission factor
· Source EF name (column Y): the original name of the emission factor (e.g. For the EF call “Light car” in the capital goods, the original source name is Véhicules - Fabrication (unit weight is 2 tons) meaning that the EF of vehicles 5500 kgCO2e/kg was multiplied with an average weight of 2 tons (approximation) for light cars which equals to 11 743 kgCO2e/units)
· Organisation name (column Z): column dedicated to new emissions factors with space to enter the name of the organisation that added an emissions factor, so that it can be traced if necessary when the database is updated.
· Assumption for scope 3 – EF (column AA) and Assumption for scope 3 – Unit (column AB): when an organisation needs to create its own EF (e.g. you need to add the EF for a SUV Toyota Car) and use assumptions, it can enter the assumption used for the EF and the unit used (e.g. the Toyota car EF was calculated based on the generic EF of ADEME for cars 5 500 kgCO2e/unit and multiplied by an average weight of 2 215 kg for a SUV car => 12 182 kgCO2e/unit as Scope 3 emission factor)
· Source of assumption – EF (column AC) and Source of assumption- Unit (column AD): columns to indicate the source of the assumptions made about the emission factor created and its unit in columns AA and AB so that the information can be traced if necessary.
· Comment (column AE): if you need to add any additional comments for the data
· Value without inflation (column AF):
· Status (column AG): the status of the emission factor (updated or NTR e.g. nothing to report)
· Old EF (column AH): the value of the emission factor from the last version of the HCC tool (before the update)
· Old EF Year (column AI): the year (of creation) related to the old emission factor.
· Old EFID (column AJ): column giving the ID of the emission factor in the HCC tool version 1. As some IDs have been changed, this column makes it easier to find the emission factors used previously.
[image: ]
How to update emission factors?

[image: ]How to update emission factors? 
· Copy the old value and paste it into the "Old FE" column
· Do the same for the date (using the "Old FE Year" column)
· Fill scope 1, 2 & 3 values in columns K-R (scope 1) and/or column S (scope 2) and/or column T (scope 3)
· Check that column J corresponds to the desired final value
· In column G, enter the creation date of the new emission factor
· Modify columns E, F, H and Y with new unit, source, location, and EF name in database if necessary.


How to proceed if my data do not correspond to the emission factors?

[image: ]How do I proceed if I only have monetary data for electricity? 
· This method should only be used if you have no way of obtaining the physical data (energy consumption in kWh). The uncertainty associated with monetary data is highly superior to that associated with physical data. 
· The conversion factor needs to be determined every year, as the electricity market is highly variable and can fluctuate significantly from one year to the next.
· First you need to find the price per kWh of electricity for the country for which you don't have the physical data. For this, several sites are reliable sources of data: 
· EU Database
· Worldwide Database: if you have a Statista account, it’s the best source you can have
· You can search manually for each country on the internet (be careful about the sources of your data) or you can use Perplexity
· Convert your monetary data into the appropriate currency
· Convert your monetary data into kWh data (by multiplying/or dividing your data by the conversion factor you've just found on step 1)
· Use the result obtained to enter it in the FE line corresponding to the concerned country 
· Given the assumptions made, please indicate a certainty of 25%
· Enter the assumption made in the tool's comments (Free Text in the Data tab or Comment space in the collection tabs)
· The same logic should be followed for other types of EF (to convert monetary values into specific values by making the best-documented assumption possible, by adapting the certainty of the data and by commenting on this assumption in the Data tab or in the collection tabs).

[image: ]How to proceed if the country of interest is not included in the lists of emission factors? 
· In this case, to apply the conservative approach, the most polluting country in the same region must be taken. 



How to add new emission factors?

[image: ]How to create a new line to add an emission factor? 
· To add an emission factor, you will need to create a new line in the appropriate category and sub-category.
· To do this, insert a line just below the last line of the sub-category.

[image: ]How to add a new emissions factor in the correct way? 
· The emission factor should come from a certified database.
· Create a new line in the emission factor tab as explained above 
· Fill in all the required information (ID number, name, unit, year, source, location) within the right category
· Fill in this e-form to share the emission factor
· Don’t forget to follow the ID methodology explained above. If the ID number already exists the cell will turn red so change it (so that the EF ID is a unique number), otherwise it means the ID is correct.

[image: ]How to create an EF using a weight emission factor (“vehicles – tons”, or “machinery & equipment – tons” for example)? 
· This method should only be used if you don't have a specific emission factor for the vehicle or the machinery.
· Search for vehicle/machinery weight. It’s far more relevant to use the weight of the vehicles you're using if you know the model. If you have no information, then you can search for an average weight on internet
Ex: ATV – average weight: 215kg, maximum weight: 450kg  
Ex bis: Snowmobiles – average weight: 300kg, maximum weight: 550kg
· Use the appropriated EF (vehicles or machinery)
Ex: for ATVs and snowmobiles we used the EF "Vehicles - ton; 5 500kgCO2e/tons" and the maximum weight to guarantee conservative assumptions:
· ATV: 0,45x5500 = 2 475 kgCO2e/unit
· Snowmobile: 0,55x5500 = 3 025 kgCO2e/unit

[image: ]How to create an EF using the raw materials of which it is mainly composed? 
· This method should only be used if you don't have an emission factor, environmental footprint or lifecycle analysis specific to this item.
· [bookmark: _Hlk160788815]Determine the raw material of which the object is composed (ideally, it should be a single-component object)
Ex: for a plastic bucket, we'd choose PET.
· Obtain or estimate the average weight of your object (an approximate wight can be found on the Internet, but it won't be very accurate)
Ex: for a 10L bucket, we know that it's about 0,5kg of PET. 
· If you have a numerical quantity of your object, multiply this number by the weight of one of the objects to find the total mass it represents.
Ex: for 100 buckets, you will have 50kg (0,5 x 100).
· Use the result as input for the PET emission factor, which added into the tool will calculate the emissions related to these 100 buckets
Ex: PET emission factor is 3,27 kgCO2e/kg. 
We have 163,5 kgCO2e for 100 plastics buckets (3,27 x 50).
· Please refer to the Appendix 


[image: ]How to use the UNHAS (ID: 40005) emission factor? 
· When seeking emissions factors for UNHAS flights, kindly submit your request to wfp.sustainability@wfp.org, while also copying jacinta.wokabi@wfp.org. WFP will address your inquiry and provide the calculated emissions factors for the flights utilised by your organisation. 
· Subsequently, please input these factors directly into the designated emissions factor field (ID of the emissions factor, ID 40005) created for that purpose.


[image: ]How to use the Microsoft (ID: 36005) emission factor? 
· To report CO2 emissions produced by your organization when using Microsoft services, please visit the following webpage: https://www.microsoft.com/en-us/sustainability/emissions-impact-dashboard. On this platform, you will find a cloud carbon tracking tool designed to assist you in achieving net-zero emissions. 
· Input the results into the designated emission factor (ID 36005).


	Main* databases used 
	Relevant scopes
	Key notes

	ADEME
	Scope 1, 2 and 3
	French base open source; partially updated annually; Contains numerous average-based emission factors

	DEFRA
	Scope 1, 2 and 3
	Open source; Updated annually; Contains numerous average-based emission factors

	Ecoinvent
	Scope 1, 2 and 3
	Paying access; Updated annually; Contains numerous emission factors for all countries and made from Life Cycle Analysis purpose 

	Quantis
	Scope 3
	Paying access; Updated annually; Contains numerous emission factors for all countries and made from Life Cycle Analysis purpose

	GLEC
	Scope 1 and 3
	Open-source access, Contains emission factors for transportation and refrigerant (Supply Chain and Logistic)

	Ecobalyse
	Scope 3
	French base open source; Textile and food emission factors



*: Emission factors can also be taken from other databases (such as Agri-footprint, HIGGS or national databases) and from life cycle analyses (it is important to check life cycle analyses, as some are not verified). The best emission factor is the one specific to your product. Favour suppliers who have studied the environmental impact of their products and who have undertaken eco-design initiatives.


[bookmark: _Ref161419684][bookmark: _Toc163496704]Allocations
In the General information tab, you will find a table summarising the possible allocations. These allocations allow you to choose a specific distribution for your data when you only have 'global' data.
· You must make sure that the sum is 100% (line 239). Otherwise, the calculations will be wrong. 

For each category, an allocation criteria per default have been assigned. 
· The « budget » criteria were selected by default for most of the categories, to simplify things for less experienced users. It turns out that for some categories, and in particular for energy or fugitive emissions, allocation by budget, even if it is the easiest to obtain, may not be the most relevant. The most relevant would be allocation by m².  As not all organisations can obtain data on the m² of each entity, we have assigned the budget as the default allocation, however this can be changed and is even better if you have information on the number of m² for each entity.
The following table shows the allocations selected by default and compares them with the best choice of allocation. If possible, choose the best allocation criteria. 
	
	By default
	Best allocation criteria 

	Stationary combustion
	Budget
	m²

	Mobile combustion
	Budget
	m²

	Purchased electricity
	Budget
	m²

	Steam, heat, cooling
	Budget
	m²

	Fugitive emissions
	Budget
	m²

	Business travels
	FTE internal
	FTE internal

	Employee commuting
	FTE internal
	FTE internal

	Volunteers
	FTE external
	FTE external

	Financial support
	Budget
	Budget

	In-kind donations
	Budget
	Budget

	Cash assistance
	Budget
	Budget

	Humanitarian products
	Budget
	Budget

	Purchased services
	Budget
	Budget

	Hotel
	Budget
	Budget

	Purchased goods
	Budget
	Budget

	Buildings
	Budget
	Budget

	Vehicles
	Budget
	Budget

	Furniture and machinery
	Budget
	Budget

	IT equipment
	Budget
	Budget

	Use of distributed products
	Budget
	Budget

	Processing of distributed products
	Budget
	Budget

	End of life of distributed products
	Budget
	Budget

	Hazardous waste
	FTE total
	FTE total

	Non-hazardous waste
	FTE total
	FTE total

	Upstream transportation and distribution
	Budget
	Budget

	Downstream transportation and distribution
	Budget
	Budget

	Upstream leased assets
	Budget
	Budget

	Downstream leased assets
	Budget
	Budget





In the General_Information tab, 3 allocations are blank (Other 1, Other 2 and Other 3), you can rename them as you wish and fill in the corresponding data. 
[image: ]
If these 3 spaces are not enough for you, you can add a new allocation category by carefully following the steps below: (CAUTION, this process is only for experienced users)
1) First of all, make sure you have saved a blank version of the tool so that you can go back if necessary. 

2) Next, copy column P (or any column surrounded by two free allocation columns) and insert the copied cells. 
· [image: How to copy and paste without overwriting in Excel - Super User]Don't panic, this operation may take some time, depending on the computing power of your computer.
[image: ]

3) Next, rename your allocation categories and enter the values you require (making sure that the sum of the values entered equals 100%).
[image: ]

4) Lines 241 to 247: Correct the inflation rate by stretching the dates and avoid having the same year twice.

5) Finally, in EACH collection tab, the calculation formulas between the IA and XK columns must be updated. This operation therefore has to be repeated many times (for all 9 collection tabs!).
Regarding this step, please follow the explanations provided in the explanation video here.

[bookmark: _Toc163496705]Inflation rate 
[image: ]In the “General Information” tab, you will find an inflation table (starting from 2018 until 2046). 

Why and when using inflation rate and what results does it affects? 
Following the GHG Protocol Methodology Standard, inflation rate is recommended for monetary data only (k-EUR) when “where applicable, inflation data to convert market values between the year of the EEIO emissions factors and the year of the activity data” GHG Protocol Standard, Scope 3
In other worlds, adding inflation rates are highly recommended when the reporting year (e.g. if the organisation’s footprint reporting year is 2021) is different from the emission factors year (e.g. Furniture and other manufactured goods – k-EUR – Base Carbone ADEME – year 2018). 
Regarding the emission factors data that are available within the tool, the last year update was 2018, 2019 and 2020, for monetary units. 
If the organisation’s reporting year is different from 2018, 2019 and 2020 years, then inflation rates to be found are world average cumulative inflation rates between the organisation reporting year and the emission factor reporting year (e.g. cumulative inflation rates from 2018 until 2021 if the reporting year is 2021)
	Monetary emission factor year (k-EUR)
	Data source 
	Inflation rate

	2018
	Base Carbone ADEME
	World average cumulative inflation rate from 2018 until reporting year

	2020 
	Quantis Database
	World average cumulative inflation rate from 2020 until reporting year

	2021
	CEDA 
	World average cumulative inflation rate from 2021 until reporting year



What kind of inflation rate are we talking about? 
The inflation rate is the world average inflation rate (average, CPI, in %) that can be found on the World bank data (https://data.worldbank.org/indicator/FP.CPI.TOTL.ZG).
Note: the inflation rate indicate in the webpage is the world average annual inflation rate (e.g. from 2020 and 2021, the annual inflation rate was 3.4%). 
How to fill in inflation rates within the tool?
Enter the cumulative inflation rate that you have calculated (see how to calculate cumulative inflation rate) from 2018 until reporting year. 
Note: that inflation rate 2018 mean the inflation rate from 2018 until reporting year.
E.g. If reporting year is 2021, the inflation rates are the following
[image: ]
[image: ]How to calculate the cumulative inflation rate: 
	Step 1: Go to https://data.worldbank.org/indicator/FP.CPI.TOTL.ZG webpage
[image: ]	Step 2: Upload the Excel data excel sheet 


[image: ]Step 3: Go to the “Data” sheet, erase all year from 1960 to 2018, and select the “Word average”


Step 4: Calculate the cumulative inflation rate 
	From year to year
	Cumulative inflation rate

	From 2018 – 2021
	2018:2021 inflation rates (1.024*1.022*1.019*1.034)-1 = 10,34%

	From 2019 – 2021
	2019:2021 inflation rates (1.022*1,019*1,034)-1 = 7,72%

	From 2020 – 2021 
	2020:2021 inflation rates (1.019*1.034)-1= 5.41%

	From 2021
	2021 inflation rates is 3.42%


[bookmark: _Aggregation_tool][image: ]

[bookmark: _Ref163491925][bookmark: _Toc163496706]Appendix 
Items without emission factors: using the raw materials.
	Item
	Raw Material

	Mozzie domes
	Yarn Polyester

	Bucket
	PET

	Cap, surgical, disposable
	Nonwoven polypropylene

	Shoe cover, non-woven, standard size, disposable
	Nonwoven polypropylene

	Face shield
	Polyethylene terephthalate

	Gown
	Nonwoven polypropylene

	Apron
	Polyethylene

	Googles
	Polycarbonate

	Overall, disposable
	Nonwoven polypropylene

	Disposable Fitted Bed Sheet
	Nonwoven polypropylene

	Jerry cans 10 l and 20 l
	HDPE or LDPE

	Floor plastic mats
	PP
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